
 

 

แผนการสอน/การเรียนรู้ภาคทฤษฎี หน่วยท่ี  1  
ชื่อวิชา  ระบบควบคุมในงานอุตสาหกรรม สอนสัปดาห์ท่ี  2-4 

ชื่อหน่วย  ความรู้เบื้องต้นของระบบควบคุมอัตโนมัติ และโปรแกรม
เมเบิลลอจิกคอมโทรลเลอร ์

คาบรวม  16  

ชื่อเรื่อง.  โปรแกรม STEP7-Micro/WIN จ านวนคาบ 12 
หัวข้อเรื่อง 

ด้านความรู้ 
1. อธิบายการใช้ โปรแกรม STEP7-MicroWIN ได้อย่างถูกต้อง 
ด้านทักษะ 
2. ปฏิบัติการใช้ โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ 

Counter ได้อย่างถูกต้อง 
ด้านคุณธรรม จริยธรรม 
3.  ความสนใจใฝ่รู้ ความรอบรู้ รอบคอบ ระมัดระวัง 

 
สาระส าคัญ 

การเขียนค าสั่งเพื่อควบคุมการท างานของเครื่องโปรแกรมเมเบิลคอนโทรลเลอร์นั้น มีลักษณะการเขียน
โปรแกรมอยู่ 3 แบบ โดยในการเขียนแต่ละแบบจ าเป็นต้องอาศัยโปรแกรมเฉพาะในการเขียนโปรแกรมเพื่อท าการ
ป้อนข้อมูลต่างๆ ให้กับเครื่องโปรแกรมเมเบิลคอนโทรลเลอร์ การเขียนโปรแกรมเพื่อควบคุมการท างานของเครื่อง
โปรแกรมเมเบิลคอนโทรลเลอร์ของเราน้ันเราจะใช้ โปรแกรม STEP7-MicroWIN 

การเขียนโปรแกรมเมเบิลลอจิกคอมโทรลเลอร์ (PLC) ควบคุมการท างานของเครื่องจักรที่ไม่ซับซ้อน 
จ าเป็นต้องใช้ค าสั่งช่วยในการเขียนโปรแกรม หรือใช้ค าสั่งกลุ่ม Bit Logic ถือว่ามีข้ันตอนที่ไม่ซับซ้อนและง่ายต่อ
การเขียนโปรแกรม 

การเขียนโปรแกรมเมเบิลลอจิกคอมโทรลเลอร์ (PLC) ควบคุมการท างานของเครื่องจักรให้ท างานตาม
ก าหนดเวลา การเริ่มท างาน หรือการหยุดท างานตามล าดับข้ันตอนการท างาน จ าเป็นต้องใช้ค าสั่งช่วยในการเขียน
โปรแกรม หรือใช้ค าสั่งกลุ่ม Timer ซึ่งมีหลายฟังก์ช่ันให้เลือกใช้ข้ึนอยู่กับรูปแบบของการหน่วงเวลาในลักษณะงาน
ต่างๆ ที่ต้องการควบคุม 

การเขียนโปรแกรมเมเบิลลอจิกคอมโทรลเลอร์ (PLC) ควบคุมการท างานของเครื่องจักรที่มีการนับจ านวน
ช้ินงานจ าเป็นต้องใช้ค าสั่งช่วยในการเขียนโปรแกรม หรือใช้ค าสั่งกลุ่ม Counter ซึ่งมีหลายฟังก์ช่ันให้เลือกใช้ข้ึนอยู่
กับลักษณะงานที่ต้องการควบคุม 

การเขียนโปรแกรมเมเบิลลอจิกคอนโทรลเลอร์ ได้อย่างถูกต้อง และช่วยเสริมสร้างทักษะความสามารถ
ทางด้านการท างานเป็นกลุม่ การแลกเปลี่ยนความรู้ซึ่งกันและกัน ท าให้นักศึกษาได้มีบทบาทในการเรียน สร้างสรรค์
บรรยากาศที่ดีจากการเรียน สามารถปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายในเวลาที่ก าหนดอย่างมีเหตุและผล 
ตามหลักปรัชญาเศรษฐกิจพอเพียง (ด้านทักษะ ด้านคุณธรรม จริยธรรม) 



 

สมรรถนะอาชีพประจ าหน่วย (สิ่งที่ต้องการใหเ้กิดการประยุกต์ใช้ความรู้  ทักษะ  คุณธรรม เข้าด้วยกัน) 
1. วางแผนควบคุมระบบไฟฟ้าด้วย PLC 

 
จุดประสงค์การสอน/การเรียนรู้ 

 จุดประสงค์ท่ัวไป / บูรณาการเศรษฐกิจพอเพียง 
1. เพื่อให้มีความรู้เกี่ยวกบัการใช้ โปรแกรม STEP7-MicroWIN (ด้านความรู้) 
2. เพื่อให้มีทักษะในการใช้ โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, 

Timer และ Counter (ด้านทักษะ) 
3. เพื่อใหม้ีเจตคติที่ดีต่อการเตรียมความพร้อมด้านการเตรียม วัสดุ-อุปกรณ์ และการปฏิบัติงานอย่าง

ถูกต้อง ส าเร็จภายในเวลาที่ก าหนด มีเหตุและผลตามหลักปรัชญาเศรษฐกิจพอเพียง และคุณลักษณะ3D (ด้าน
คุณธรรม จรยิธรรม และคุณลักษณะ3D) 
 

 จุดประสงค์เชิงพฤติกรรม / บูรณาการเศรษฐกิจพอเพียง 
1. อธิบายการใช้ โปรแกรม STEP7-MicroWIN ได้อย่างถูกต้อง (ด้านความรู)้ 
2. ปฏิบัติการใช้ โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 

Counter ได้อย่างถูกต้อง (ด้านทักษะ) 
3. ปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายในเวลาที่ก าหนดอย่างมีเหตุและผลตามหลักปรัชญาเศรษฐกจิ

พอเพียงและคุณลกัษณะ3D (ด้านคุณธรรม จรยิธรรม/บูรณาการเศรษฐกิจพอเพียง และคุณลักษณะ3D) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

การบูรณาการกับปรัชญาของเศรษฐกิจพอเพียง 

• หลักความพอประมาณ 
1. ผู้เรียนจัดสรรเวลาในการฝึกปฏิบัติการเขียน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้

ค าสั่งกลุ่ม Bit Logic, Timer และ Counter ได้อย่างเหมาะสม 
2. ก าหนดเนื้อหาเหมาะสมกับเกณฑ์การประเมินการฝึกปฏิบัตกิารเขียน โปรแกรม STEP7-Micro/WIN 

เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ Counter 
3. ผู้เรียนปฏิบัติตนเป็นผู้น าและผู้ตามที่ด ี
4. ผู้เรียนเป็นสมาชิกที่ดีของกลุ่มเพื่อนและสงัคม 

• หลักความมีเหตุผล 
1. เห็นคุณค่าของการเขียน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, 

Timer และ Counter ได้อย่างชัดเจนและถูกต้อง 
2. ทดลองเขียน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 

Counter ได้อย่างถูกต้อง มีเหตุผล และสามารถน าไปประยกุต์ใช้ในการท างานได ้
3. กล้าแสดงความคิดอย่างมีเหตผุล 
4. กล้ายอมรับฟังความคิดเห็นของผูอ้ื่น 
5. ไม่มีเรือ่งทะเลาะวิวาทกับผู้อื่น 
6. มีความคิดวิเคราะห์ในการแก้ปญัหาอย่างเป็นระบบ 

• หลักความมีภูมิคุ้มกัน 
1. มีทักษะในการเขียน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสัง่กลุม่ Bit Logic, Timer 

และ Counter อย่างมีประสิทธิภาพ 
2. ผู้เรียนได้รับความรู้ที่ถูกต้อง พร้อมทั้งก าหนดเนือ้หาได้ครบถ้วนถูกต้องจากการเขียน โปรแกรม STEP7-

Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ Counter และมสีาระส าคัญที่สมบรูณ์ 
3. มีการเตรียมความพร้อมในการเรียนและการปฏิบัติงาน 
4. กล้าซักถามปัญหาหรือข้อสงสัยต่างๆ อย่างถูกกาลเทศะ 
5. แก้ปัญหาเฉพาะหน้าได้ด้วยตนเองอย่างเป็นเหตเุป็นผล 
6. ควบคุมอารมณ์ของตนเองได ้
7. ควบคุมกิริยาอาการในสถานการณ์ต่างๆ ได้เป็นอย่างด ี

 
 
 
 
 
 



 

การตัดสินใจและการด าเนินกิจกรรมต่างๆ ให้อยู่ในระดับพอเพียงหรือตามปรัชญาของเศรษฐกิจพอเพียงน้ัน 
ต้องอาศัยท้ังความรู้และคุณธรรมเป็นพ้ืนฐาน ดังน้ี 
 

• เง่ือนไขความรู้ 
1. ผู้เรียนได้ใช้กระบวนการคิดในการทดลองเขียนการเขียน โปรแกรม STEP7-Micro/WIN เขียนการ

ท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ Counter (ความสนใจใฝรู่้  ความรอบรู้ รอบคอบ ระมัดระวัง) 
2. มีความรู้ ความเข้าใจในการเขียน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit 

Logic, Timer และ Counter 
3. ปฏิบัติงานด้วยความละเอียดรอบคอบ 
4. มีความรู้ ความเข้าใจเกี่ยวกบัหลักปรัชญาของเศรษฐกิจพอเพียง 

• เง่ือนไขคุณธรรม 
1. ปฏิบัติงานที่ได้รบัมอบหมายเสรจ็ตามก าหนด (ความรับผิดชอบ) 
2. มีความเพียรพยายามและกระตอืรือร้นในการเรียนและการปฏิบัติงาน (ความขยัน ความอดทน) 
3. ให้ความร่วมมือกับการท ากจิกรรมของส่วนรวม อาสาช่วยเหลืองานครูและผู้อื่น (แบ่งปัน) 
 

การบูรณาการกับคุณลักษณะ 3 D แก่ผู้เรียน 

• ด้านประชาธิปไตย (Democracy) 
1. การใหผู้้ฟังแสดงความคิดเห็นภายในช้ันเรียนได้อย่างอสิระ 

• ด้านคุณธรรมจริยธรรมและความเป็นไทย (Decency) 
1. ปฏิบัติงานที่ได้รบัมอบหมายเสรจ็ตามก าหนด (ความรับผิดชอบ) 
2. มีความเพียรพยายามและกระตอืรือร้นในการเรียนและการปฏิบัติงาน (ความขยัน ความอดทน) 
3. ให้ความร่วมมือกับการท ากจิกรรมของส่วนรวม อาสาช่วยเหลืองานครูและผู้อื่น (แบ่งปัน)  

• ด้านภูมิคุ้มกันภัยจากยาเสพติด (Drug - Free)  
1. การปลูกฝังให้นักศึกษาเอาใจใส่ในการเรียนรู้ดหูนังสืออย่างสม่ าเสมอ และสง่เสรมิใหเ้ล่นกีฬาอยู่เสมอ

เพื่อใหร้่างกายแข็งแรงความจ าดี เป็นการใช้เวลาว่างใหเ้ป็นประโยชน์  ซึ่งส่งผลท าใหห้่างไกลจากยาเสพติดอย่าง
แท้จรงิ 
 
 
 
 
 
 
 



 

เน้ือหาสาระการสอน/การเรียนรู้ 

 ด้านความรู้ (ทฤษฎี) 
1.  โปรแกรมเมเบิลคอนโทรลเลอร์  (จุดประสงค์เชิงพฤติกรรมข้อที่ 1) 

 

 ด้านทักษะ (ปฏิบัติ)  (จุดประสงค์เชิงพฤติกรรมข้อที่ 2) 

1. การเขียนโปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 
Counter 

 

 ด้านคุณธรรม/จริยธรรม/จรรยาบรรณ/บูรณาการปรัชญาของเศรษฐกิจพอเพียงและคุณลักษณะ 3D  
(จุดประสงค์เชิงพฤติกรรมข้อที่  3) 

1. การเตรียมความพร้อมด้านการเตรียม วัสด-ุอุปกรณ์ นักศึกษาจะต้องกระจายงานได้ทั่วถึง และตรงตาม
ความสามารถของสมาชิกทกุคน มีการจัดเตรียมวัสด-ุอุปกรณ์ไว้อย่างพร้อมเพรียง และนักศึกษาทกุคนจะต้องรูจ้ักใช้ 
และจัดการกบัวัสด-ุอุปกรณ์เหล่าน้ันอย่างคุ้มค่า และประหยัด งานจะส าเรจ็ได้นักศึกษาจะต้องมีความขยันอดทน มี
ความเพียรพยายาม และกระตือรอืร้นในการเรียน และการปฏิบัติงาน และรู้จกัแบ่งปันให้ความร่วมมือกบัการท า
กิจกรรมของส่วนรวม ตามหลักปรัชญาของเศรษฐกจิพอเพียง และหลักคุณลกัษณะ 3D 

2. ความมีเหตุมผีลในการปฏิบัติงาน ตามหลักปรัชญาของเศรษฐกิจพอเพียง และหลักคุณลกัษณะ3D
นักศึกษาจะต้องมีการ ปฏิบัติงานด้วยความละเอียดรอบคอบ  นักศึกษาจะมีภูมิคุ้มกันในตัวที่ดีได้นักศึกษาจะต้องมี
ความสนใจใฝรู่้ รอบรู้ รอบคอบ และระมัดระวัง 
 
          (จะสอนเน้ือหาอะไรท่ีเกี่ยวกับการเตรียมความพร้อมด้านการเตรียม วัสดุ  อุปกรณ์     และการ 
                 ปฏิบัติงานอย่างมี เหตุและผลตามหลักปรัชญาเศรษฐกิจพอเพียงและคุณลักษณะ 3D) 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
กิจกรรมการเรียนการสอนหรือการเรียนรู้ 

ขั้นตอนการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
ขั้นเตรียม  (30 นาที) 

1. จัดเตรียมเอกสาร สื่อการเรียนการสอนแนะน า
รายวิชา  วิธีการเรียน  การมอบหมายงาน และวิธีวัดผล
ประเมินผล 

2.  แจ้งจุดประสงค์การเรียนของหน่วยเรียนที่ 1  
และการให้ความร่วมมอืของนักศึกษาในการท ากจิกรรม 
 
ขั้นการเรียนการสอน  (180 นาที) 

1. ครูอธิบาย โปรแกรม STEP7-Micro/WIN เขียน
การท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ 
Counter (บรรลุจุดประสงค์เชิงพฤติกรรมข้อที่ 1) 

2. แบ่งกลุม่นักศึกษา กลุม่ละ 1-6  คน แล้ว
มอบหมายงาน เรื่องการเขียนโปรแกรม STEP7-
Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit 
Logic, Timer และ Counter 
(บรรลุจุดประสงค์เชิงพฤติกรรมข้อที่ 2) 
 
 
ขั้นสรุป (30 นาที) 

1. ครูสรปุจากที่นักศึกษาท างานพร้อมทัง้อธิบาย
เพิ่มเตมิ และสรุปเนื้อหาตามจุดประสงค์เชิงพฤติกรรม 
ตามหัวข้อสาระส าคัญพร้อมทั้งปลูกฝังให้นักศึกษาเอา
ใจใส่ในการเรียนรู้ ดูหนงัสืออย่างสม่ าเสมอ และสง่เสรมิ
ให้เล่นกีฬาอยู่เสมอเพื่อให้ร่างกายแข็งแรง ความจ าดี 
เป็นการใช้เวลาว่างใหเ้ป็นประโยชน์ (ส่งผลท าใหห้่างไกล
จากยาเสพติดอย่างแท้จริง Drug-Free ด้านภูมิคุม้กันภัย
จากยาเสพติด : 3D) 
(บรรลุจุดประสงค์เชิงพฤติกรรมข้อที่3) 

ขั้นเตรียม  (30 นาที) 
1. จัดเตรียมเอกสาร สื่อการเรียนการสอนตามที่

อาจารยผ์ู้สอนและบทเรียนก าหนด 
2. ท าความเข้าใจเกี่ยวกับจุดประสงค์การเรียนของ

หน่วยเรียนที่ 1  และการให้ความร่วมมือในการท า
กิจกรรม 
 
ขั้นการเรียนการสอน (180 นาที) 

1. นักศึกษาฟังและคิดตามพร้อมทั้งจดบันทึกเกี่ยวกับ
โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้
ค าสั่งกลุ่ม Bit Logic, Timer และ Counter  พร้อมกบั
ศึกษาใบความรูป้ระกอบการเรียนการสอนเรื่อง โปรแกรม 
STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ 
Bit Logic, Timer และ Counter (บรรลุจุดประสงค์เชิง
พฤติกรรมข้อที่ 1) 
2. เข้ากลุ่มตามที่ครจูัดแบ่ง แล้วเขียนส่วนประกอบของ
โปรแกรมเมเบลิลอจิกคอนโทรลเลอร์(บรรลุจุดประสงค์เชิง
พฤติกรรมข้อที่ 2) 
ขั้นสรุป (30 นาที) 

1. นักศึกษารับฟังค าสรปุและข้อแนะน าจากครูพร้อม
ทั้งจดบันทึกข้อมูล และซักถามหรอืตอบค าถามหรือ
แสดงความคิดเห็น ในหัวข้อที่ยงัไม่เข้าใจพร้อมทั้งรับฟัง
การปลูกฝังจากท่านอาจารยเ์รื่องการเอาใจใส่ในการ
เรียนรู้ ดูหนังสืออย่างสม่ าเสมอ และส่งเสริมให้เล่นกีฬา
อยู่เสมอเพือ่ใหร้่างกายแข็งแรง ความจ าดี เป็นการใช้
เวลาว่างใหเ้ป็นประโยชน ์(ส่งผลท าใหห้่างไกลจากยา
เสพติดอย่างแท้จริง Drug-Free ด้านภูมิคุ้มกันภัยจากยา
เสพติด : 3D) 
(บรรลุจุดประสงค์เชิงพฤติกรรมข้อที่ 3) 
 



 

งานท่ีมอบหมายหรือกิจกรรมการวัดผล และประเมินผล 
 

 ก่อนเรียน 
1. ท าความเข้าใจเกี่ยวกบัจุดประสงค์การเรียนของหน่วยเรียนที่ 1  และการให้ความร่วมมอืในการท ากิจกรรม

ในหน่วยการเรียนที่ 1 
    

 ขณะเรียน 
1. ปฏิบัติตามงานที่ 1 เรื่องการโปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, 

Timer และ Counter 
 

 หลังเรียน 
1. ตรวจสอบ และจัดเกบ็ วัสด-ุอุปกรณ์ที่ใช้ในการทดลองให้อยู่ในสภาพเรียบรอ้ยพร้อมใช้งาน 

 
ผลงาน/ชิ้นงาน/ความส าเร็จของผู้เรียน 

โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุ่ม Bit Logic, Timer และ Counter  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

สื่อการเรียนการสอน/การเรียนรู้ 
สื่อสิ่งพิมพ์ 

1. ใบความรู้บทที่ 1 เรื่อง โปรแกรมเมเบลิลอจิกคอมโทรลเลอร์ (ใช้ประกอบการเรียนการสอนข้ันสอน 
เพื่อใหบ้รรลจุุดประสงค์เชิงพฤติกรรมข้อที่ 1) 

2. งานที่ 2 เรื่อง โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 
Counter (ใช้ประกอบการเรียนการสอนจุดประสงค์เชิงพฤตกิรรมข้อที่ 2) 

 
สื่อโสตทัศน์ 

                         -- 
   
สื่อของจริง 

                         -- 
 
แหล่งการเรียนรู้ 

ในสถานศึกษา 
1. ห้องสมุดวิทยาลัยการอาชีพพิมาย 
2. ห้องปฏิบัติการคอมพิวเตอร์  ศึกษาหาข้อมูลการสตาร์ทมอเตอร์ไฟฟ้ากระแสสลบั 3 เฟสด้วย PLC ทาง  

Internet 
นอกสถานศึกษา 

                         -- 
 
การบูรณาการ/ความสัมพันธ์กับวิชาอ่ืน 
                         -- 
 
 
 
 
 
 
 
 
 
 
 



 

การประเมินผลการเรียนรู้ 

 หลักการประเมินผลการเรียนรู้ 
ก่อนเรียน. 

                         -- 
 

ขณะเรียน 
1. ตรวจผลการ โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 

Counter ที่ละข้ันตอน 
2. สังเกตพฤติกรรมการท างานเป็นกลุ่ม 

 
หลังเรียน 

                         -- 
 

 ผลงาน/ชิ้นงาน/ผลส าเร็จของผู้เรียน 
ตรวจผลงาน  โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่งกลุม่ Bit Logic, Timer และ 

Counter 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

รายละเอียดการประเมินผลการเรียนรู้ 

 จุดประสงค์เชิงพฤติกรรม ข้อท่ี 1 อธิบายหลักการโปรแกรม STEP7-MicroWIN ได้อย่างถูกต้อง 
1. วิธีการประเมิน          :   ถาม-ตอบ 
2. เครื่องมือ                     :   แบบประเมินผลการเรียนรู้ และการทดลอง 
3. เกณฑ์การให้คะแนน   :    อธิบาย โปรแกรม STEP7-MicroWIN ได้ จะได้  5  คะแนน    
4. เกณฑ์การตัดสินการผ่าน   :   ผ่านระดับร้อยละ 80 (ต้องได้คะแนนไม่น้อยกว่า 4 คะแนน) 

 จุดประสงค์เชิงพฤติกรรม ข้อท่ี 2  ทดสอบการท างาน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดย
ใช้ค าสั่งกลุ่ม Bit Logic, Timer และ Counter ด้วย PLCได้อย่างถูกต้อง 
1. วิธีการประเมิน         :   ทดสอบการท างาน 
2. เครื่องมือ                      :   แบบประเมินผลการเรียนรู้ และการทดลอง 
3. เกณฑ์การให้คะแนน     :    ทดสอบการท างาน โปรแกรม STEP7-Micro/WIN เขียนการท างานโดยใช้ค าสั่ง

กลุ่ม Bit Logic, Timer และ Counter ด้วย PLCได ้จะได้  5  คะแนน    
4. เกณฑ์การตัดสินการผ่าน   :   ผ่านระดับร้อยละ  80  (ต้องได้คะแนนไม่น้อยกว่า 4 คะแนน) 

 จุดประสงค์เชิงพฤติกรรม ข้อท่ี 3 ปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายใน เวลาที่ก าหนดอย่างมีเหตุ
และผลตามหลักปรัชญาเศรษฐกิจพอเพียงและคุณลักษณะ3D 
1. วิธีการประเมิน         :     ตรวจผลการทดลอง 
2. เครื่องมือ                :     แบบประเมินผลการเรียนรู้ และการทดลอง 
3. เกณฑ์การให้คะแนน       :    ปฏิบัติงานได้อย่างถูกต้อง และส าเร็จภายใน เวลาที่ก าหนดอย่างมีเหตุ และ 
ผลตามหลักปรัชญาเศรษฐกิจพอเพียง  จะได้  5  คะแนน    
4. เกณฑ์การตัดสินการผ่าน    :    ผ่านระดับร้อยละ  80  (ต้องได้คะแนนไม่น้อยกว่า 4.00 คะแนน) 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

... ใบความรู้ ... 
      บทท่ี 1  

โปรแกรม STEP7-MicroWIN 
 
 ในการเขียนค าสั่งเพื่อควบคุมการท างานของเครื่องโปรแกรมเมเบิลคอนโทรลเลอร์นั้น มีลักษณะการเขียน
โปรแกรมอยู่ 3 แบบ โดยในการเขียนแต่ละแบบจ าเป็นต้องอาศัยโปรแกรมเฉพาะในการเขียนโปรแกรมเพื่อท าการ
ป้อนข้อมูลต่างๆ ให้กับเครื่องโปรแกรมเมเบิลคอนโทรลเลอร์ 
 
1. โปรแกรม STEP7-MicroWIN 

เมื่อเราเปิดโปรแกรม STEP7-Micro/WIN จะปรากฏหน้า Program Editor ข้ึนมาเพื่อใช้ในการสร้าง 
Project ตามที่ได้ท าการออกแบบไว้ แต่ก่อนที่จะท าการสรา้ง Project ได้น้ันเราต้องท าการศึกษารายละเอียดการใช้
งานของแต่ละส่วนของโปรแกรมก่อน 
 

 
 

รูปท่ี 6.1 โปรแกรม STEP7-MicroWIN 
 



 

Menu Bar     เป็นชุดเมนูค าสั่งของโปรแกรมได้แก่ File, Edit, View, PLC, Debug, Tools, Window 
และ Help 

Toolbars     เป็นแถบเครื่องมือแสดงในรูปของไอคอนที่แทนค าสั่งที่เรียกใช้งานบ่อย 
Navigation Bar     เป็นไอคอนแสดงกลุ่มของการควบคุม ได้แก่ 

 กลุ่ม View ปุ่มควบคุมส าหรับ Program Block, Symbol Table, Status Chart, Data Block, 
System Block, Cross Reference, Communications, และ Set PG/PC Interface 

 กลุ่ม Tool ปุ่มควบคุมส าหรับ Instruction Wizard, TD 200 Wizard, Position Control Wizard 
EM 253 Control Panal, Modem Expansion Wizard, Ethernet Wizard, AS-I  Wizard, 
Internet Wizard, Recipe Wizard, Data Log Wizard, PId Tune Control Panal, S7-200 
Explorer, TD Keypad Designer 

Instruction Tree     เป็นส่วนแสดงโครงสร้างของ Project และแสดงกลุ่มค าสั่งโดยสามารถลาก หรือ
ดับเบิลคลิก ค าสั่งมาวางใน Program Editor ได ้

Output Window     เป็นส่วนที่แสดงข้อมูลเมื่อท าการ compile โปรแกรมเช่น ขนาดของ Project 
แสดงการ Error ของโปรแกรม และสาเหตุของการ Error Program Editor Window หรือ Main Program (OB1) 
จะมี Local Variable Table และส่วนที่ใช้เขียนโปรแกรม (LAD, FBD หรือ STL) โดยเราสามารถสร้าง 
Subroutines หรือ Interrupt Routines เพิ่มข้ึนได้ โดยปกติจะมี Subroutines และ Interrupt Routines อยู่แล้ว 
ซึ่งจะมีช่ือแสดงอยู่ที่ด้านล่างโปรแกรมสามารถสลับการท างานระหว่างหน้าต่าง Main Program (MAN), 
Subroutines (SBR_0) และ Interrupts routines (INT_0) 

Local Variable Table     เป็นตารางก าหนดค่าตัวแปรเฉพาะ (Local Variable) เพื่อใช้ใน 
Subroutines และ Interrupt routines ตัวแปรที่สร้างใน Local Variable Table จะใช้หน่วยความจ าช่ัวคราว
ต าแหน่ง Address จะถูกก าหนดโดยระบบ และจะใช้ตัวแปรที่จ ากัดอยู่ใน POU เท่านั้น 

Symbol Table Window     เป็นส่วนที่ใช้ในการก าหนดและแก้ไขตัวแปรสัญลักษณ์ สามารถสร้าง
สัญลักษณ์แทนลงในตาราง (Table) และอ้างต าแหน่ง Address ได ้

Status Chart Window     เป็นส่วนที่แสดงสภาวะของ Input, Output หรือ สัญลักษณ์แสดงในรูปแบบ
ของ Chart สามารถสร้าง Status Chart ได้หลายแบบ 

Data Block Window     เป็นส่วนแสดงและแก้ไขรายละเอียดของ Data Block 
Cross Reference     เป็นมุมมองในการอ้างอิง และส่วนประกอบที่ถูกใช้ในค าสั่งของโปรแกรม 
Status Bar     เป็นส่วนแสดงสถานการณ์ท างานของโปรแกรม STEP 7 Micro / WIN 

 
2. อุปกรณ์เชื่อมต่อระหว่าง Personal Computer กับ PLC  

ในการท างานของเครื่องจกัรกลทีใ่ช้ PLC มาเป็นตัวควบคุมการท างานนั้น PLC จะสั่งงานให้เครื่องจกัรกลท างาน
ตามเงื่อนไขที่เราก าหนดได้น้ันก็จะต้องมีการสร้างเงื่อนไข และน าเงื่อนไขในการควบคุมนั้นมาเขียนโปรแกรมผ่าน
อุปกรณ์ ซึ่งอุปกรณ์ในการเขียนโปรแกรมอาจจะใช้ตัวเขียนโปรแกรมก็ได้หรือที่เรียกว่า Handy Program หรืออาจ



 

มีการเขียนจากโปรแกรมบน Software ผ่านเครื่องคอมพิวเตอร์ ซึ่งในหัวข้อนี้จะขอกล่าวถึงการเขียนโปรแกรมบน
เครื่องคอมพิวเตอร์ผ่าน Software Step 7-Micro/WIN ซึ่งในการเช่ือมต่อสื่อสารระหว่าง PC กับ PLC เราจะใช้
สาย PC/PPI Cable ที่มีความแตกต่างจากสายเช่ือมต่อสื่อสารของ PLC โดยทั่วไป 

 

 
 

รูปท่ี 6.2 อุปกรณ์เช่ือมต่อระหว่าง Personal Computer กับ PLC 
การเช่ือมต่อสื่อสารระหว่างเครื่องคอมพิวเตอร์กับ PLC Siemens S7-200 นั้นต้องใช้สาย PC/PPI Cable ซึ่ง

สายชนิดนี้มีความแตกต่างจากสายเช่ือมของ PLC โดยทั่วไป เนื่องจากตัวสายมี Adaptor ในการแปลงสัญญาณ RS 
232 จาก Series Port ของคอมพิวเตอร์เป็น RS 485 ที่ใช้กับ PLC Siemens S7-200 ในปัจจุบันก็มีสาย PC/PPI 
ให้เลือกใช้ 2 แบบด้วยกันคือ แบบ USB แบบ RS 232 (COM  PORT) 

จากรูปที่ 6.3 ถ้าเราสังเกตที่ Adapter แปลงสัญญาณจะเห็นว่ามีการปรับตั้ง Dipswitch ซึ่งในการใช้งานเรา
อาจจะต้องสังเกตต าแหน่งของ Dipswitch ว่ามีการปรับตั้งอัตราการส่งข้อมูลตรงกับที่ตั้งไว้ใน Software ซึ่งถ้ามี
การปรับตั้งไม่ตรงกันการเช่ือมต่อสื่อสารอาจจะไม่ส าเร็จ ในการปรับตั้งอัตราการส่งข้อมูลที่ใช้กันโดยส่วนมากจะ
เท่ากับ 9.6 Kbytes 

 

 
รูปท่ี 6.3 สาย PC/PPI Cable 

 
 



 

3. การ Interface ระหว่างคอมพิวเตอร์กับ PLC 
ในการเขียนค าสั่งเพื่อควบคุมการท างานของเครื่องโปรแกรมเมเบิลคอนโทรลเลอร์ โดยใช้ โปรแกรม 

STEP7-Micro/WIN นั้น ทุกครั้งจะต้องท าการ Interface โดยท าการติดตั้งสาย PC/PPI ระหว่างคอมพิวเตอร์กับ 
PLC ก่อนทุกครั้ง ในการ Interface มีขั้นตอนดังต่อไปนี้ 

3.1 เข้าสู่ไดอะล็อกซ์ Communication 

 คลิกที่ไอคอน Communication ใน Navigation Bar 

 คลิกที ่Menu Bar > View > Component > Communication  
 

 
รูปท่ี 6.4 การ Communication ใน Navigation Bar หรือใน Menu Bar 

3.2 เข้าสู่ไดอะล็อกซ์ Set PG/PC Interface 

 คลิกที่ปุม่ Set PG/PC Interface 

 ดับเบลิคลกิที่ไอคอน PG/PC Cable (PPI) 
 
 
 
 
 
 
 

คลิก 

คลิก 



 

 
รูปท่ี 6.5 การ Set PG/PC Interface 

 
3.3 คลิกปุ่ม Properties จะปรากฏไดอะล็อกซ์ Properties PC/PPI Cable (PPI) ในแท็ป PPI 
3.4 ตรวจสอบความถูกต้องของการ Interface ค่าที่ก าหนดของอัตราการส่งข้อมูลคือ 9600 baud (9.6 Kbps) 

 
รูปท่ี 6.6 ไดอะล็อกซ์ Properties PC/PPI Cable (PPI) 

 
 
 
 
 

คลิก 



 

3.5 คลิกที่แทป็ Local Connection เพื่อเลือกต าแหนง่ Port ที่ต่อกับเครื่องคอมพิวเตอร์ให้ถูกต้อง 
 

 
รูปท่ี 6.7 Local Connection เพื่อเลือกต าแหนง่ Port 

 
3.6 คลิกที่ปุม่ OK ในไดอะล็อกซ์ Properties PC/PPI Cable (PPI) 
3.7 คลิกที่ปุม่ OK ในไดอะล็อกซ์ Set PG/PC Interface 
3.8 ดับเบลิคลกิไอคอน Double-Click to Refresh ในไดอะล็อกซ์ Communication เพื่อค้นหารุ่นและ 

Version ของ CPU ของ PLC 
 
4. การสรา้ง Project 

ในตัวอย่างนี้เป็นการสร้าง Project อย่างง่าย เพื่อให้เข้าใจพื้นฐานการสร้าง Project โดยใช้ภาษา Ladder 
Diagram บน Instruction Tree 

4.1 สร้าง Project ใหม่ 

 คลิกที่ค าสั่ง File > New 
 
 
 
 
 
 
 

รูปท่ี 6.8 การสร้าง Project ใหม่ด้วย Menu Bar 
 

คลิก 



 

 คลิกที่ปุม่ New Project บนแถบเครื่องมือ Standard 
 
 
 
 

รูปท่ี 6.9 การสร้าง Project ใหม่ด้วย Toolbars 
 

4.2 สร้าง Project ด้วยภาษา Ladder diagram (LAD) 

 คลิกเมาส์ในต าแหนง่ที่จะวางค าสั่งใน Network ที่เลือก 

 ดับเบลิคลกิที่โฟลเดอร์กลุ่มค าสั่งที่ตอ้งการ หรอืคลิกที่เครือ่งหมายบวกหน้าโฟลเดอรก์ลุ่มค าสั่ง 

 คลิกเลือกค าสั่งที่ต้องการแล้วลากเมาส์ไปที่ต าแหน่งทีจ่ะวางค าสั่งและปล่อยเมาส์ หรือดับเบลิคลกิที่
ค าสั่งนั้นๆ ก็ได ้

 
รูปท่ี 6.10 การสร้าง Project ด้วยภาษา Ladder diagram (LAD) 

 

 ก าหนด Operand และ Address ตามรูปแบบที่ถูกต้อง เช่น I0.0, Q0.0, T200 เป็นต้น แล้วกดที่ปุม่ 
Enter 

 
รูปท่ี 6.11 การก าหนด Operand และ Address 

 
 
 

คลิก 

คลิก 

คลิก 

คลิก 



 

4.3 ตัวอย่างการเขียนโปรแกรม โดยใช้ภาษา Ladder Diagram 

 
รูปท่ี 6.12 การเขียนโปรแกรม โดยใช้ภาษา Ladder Diagram 

 
5. การ Compile Project 

เมื่อเราสร้าง Project (Ladder Diagram) เรียบรอ้ยแล้วใหท้ าการ Compile Project เพื่อตรวจสอบความ
สมบรูณ์ของ Project โดยมีขั้นตอนดังนี ้

5.1 Compile  Project 

 คลิกที่ค าสัง่ PLC > Compile หรือ Compile All 

 คลิกที่ปุม่ Compile หรือ Compile All บนแถบเครื่องมือ Standard 

 Compile คือ จะท าการ Compile เฉพาะหน้าต่าง Program Block 

 Compile All คือ จะท าการ Compile ทั้งหมดคือหน้าต่าง Program Block Data Block, System 
Block 

 
รูปท่ี 6.13 การ Compile Project ด้วย Menu Bar และ Toolbars 

5.2 ตรวจสอบผลของ Project ที่ Output window เพื่อตรวจสอบว่า Project สามารถ Compile ผ่านหรือไม่ 
ถ้าหากการ Compile ไม่ผ่านจะสงัเกตไดจ้ากข้อความแสดงการ Error  ในต าแหน่งใด ๆ และรหสัการ 
Error พร้อมทั้งสาเหตุการ Error นั้น นอกจากนี้ Output window ยังบอกขนาดของ Project ด้วย 

5.3 ท าการแก้ไข Project ในต าแหน่งที่เกิดการ Error ให้ถูกต้อง แล้วท าการ Compile อีกครั้ง 
6. การ  Download Project 

เมื่อ Project ท าการ Compile ผ่านแล้ว และต้องการ Download Project ให้กับ PLC ก่อนท าการ 
Download ให้ตรวจสอบสภาวะของ PLC จะต้องอยู่ใน Mode STOP ก่อน หากไม่อยู่ใน Mode STOP ให้เลื่อน
ต าแหน่งสวิทซ์ของ PLC ไปที่ Mode STOP หรือเปิดเมนู PLC เลือก STOP หรือคลิกที่ไอคอน Download บนแถบ
เครื่องมือ Debug การ Download มีขั้นตอนดังนี้ 

คลิก 

คลิก 



 

6.1 Download Project 

 คลิกที่ค าสั่ง File > Download 

 
รูปท่ี 6.14 การ Download Project ด้วย Menu Bar และ Toolbars 

 

 คลิกที่ปุ่ม Download บนแถบเครื่องมือ Debug จะปรากฏไดอะล็อกซ์ โดยค่าที่ก าหนดของ Options 
จะเลือกในส่วนของ Program Block, Data Block และ System Block 

 
รูปท่ี 6.15 การ Download Project บนแถบเครื่องมือ Debug 

 
6.2 คลิกที่ปุ่ม Download เมื่อผ่านแล้วที่หน้าต่าง Output Window จะแสดงสถานะ Download 

Successful 
7. การ  RUN-STOP Project 

หลังจากการ Download Project ให้กับ PLC เรียบร้อยแล้ว ให้ท าการ RUN Project 
7.1 RUN Project 

 คลิกที่ค าสั่ง PLC > RUN 

 คลิกที่ปุ่ม RUN บนแถบเครื่องมือ Debug จะปรากฏไดอะล็อกซ์ RUN 
 

คลิก 

คลิก 

คลิก 



 

 
 
 

รูปท่ี 6.16 การ Run Project ด้วย Menu Bar และ Toolbars 
 

7.2 ตรวจสอบ Dip Switch ต าแหน่งของ PLC อีกครั้งให้อยู่ในต าแหน่ง RUN Mode แล้วคลิกที่ปุ่ม Yes 
จากนั้น Program จะท าการ RUN Project เมื่อต้องการหยุดการท างาน ให้ท าการ STOP Project 

7.3 STOP  Project 

 คลิกที่ค าสั่ง PLC > STOP 
 

 
 
 
 

รูปท่ี 6.17 การ Stop Project ด้วย Menu Bar และ Toolbars 
 

 คลิกที่ปุ่ม STOP บนแถบเครื่องมือ Debug จะปรากฏไดอะล็อกซ์ STOP 
7.4 คลิกที่ปุ่ม Yes 

 
8. ดูสถานการณ์ท างานของ Project 

ในขณะที่ท าการ RUN Project เราสามารถตรวจดูสภาวะการท างานของ Project ได้ดังนี ้
8.1 การเปิด Program Status 

 คลิกที่ค าสั่ง Debug > Start Program Status 

 คลิกที่ปุ่ม Program Status บนแถบเครื่องมือ Debug จากนั้นที่ Project จะปรากฏแท็ปสี และข้อมูล 
แสดงสภาวะการท างานของ Project 

 

คลิก คลิก 

คลิก 

คลิก 



 

 
รูปท่ี 6.18 การ Start Program Status ด้วย Menu Bar และ Toolbars 

 
8.2 การปิด Program Status 

 คลิกที่ค าสั่ง Debug > Stop Program Status 

 คลิกที่ปุ่ม Program Status บนแถบเครื่องมือ Debug 
 

 
รูปท่ี 6.19 การ Stop Program Status ด้วย Menu Bar และ Toolbars 

9. บันทึก  Project 
หลังจากที่เราสร้าง Project เสร็จแล้ว และต้องการบันทึก Project มีขั้นตอนดังนี้ 

9.1 เข้าสู่ ไดอะล็อกซ์ Save หรือ Save As 

 
รูปท่ี 6.20 การ Save ด้วย Menu Bar และ Toolbars 

คลิก 

คลิก 

คลิก 

คลิก 

คลิก 

คลิก 



 

 

 คลิกที่ค าสั่ง File > Save หรือ Save As 

 คลิกที่ปุ่ม Save บนแถบเครื่องมือ Standard 
9.2 เลือกต าแหน่งในการบันทึกในช่อง Save in 
9.3 ใส่ช่ือ Project ในช่อง File Name 
 

 
รูปท่ี 6.21 การ Save Project 

 
9.4 ในช่อง Save at type ก าหนดสกุลเป็น *.wmp เท่านั้น 
9.5 คลิกที่ปุ่ม Save 

  
 
 
 
 
 
 
 
 
 
 
 
 
 



 

... ใบความรู้ ... 
      บทท่ี 1 

ค าสั่งพ้ืนฐานในการเขียนแลดเดอร์ไดอะแกรม 
 
 ในการเขียนโปรแกรม PLC เพื่อควบคุมการท างานในรูปแบบต่างๆ นั้นก็จะมีลักษณะการเขียนได้หลาย
ภาษาดังได้กล่าวไปแล้วในบทที่ผ่านมา แต่ส าหรับบทต่อไปนี้จะเป็นการเขียนโปรแกรมในภาษาหนึ่งที่มีลักษณะรูป
คล้ายวงจรทางไฟฟ้า หรือที่เรียกว่าแลดเดอร์ ซึ่งการเขียนโปรแกรมภาษาแลดเดอร์ จัดว่าเป็นภาษาที่ในการเขียนที่
เป็นลักษณะของสัญลักษณ์ที่เราสามารถดูโครงสร้างและเข้าใจการท างานได้เป็นอย่างดี 
 ในการใช้ค าสั่งต่างๆ ของ Software STEP7-Micro/WIN ในการเขียนโปรแกรมเพื่อสั่งงาน PLC Siemens 
S7-200 ก็จะมีกลุ่มค าสั่งต่างๆ ให้เลือกใช้งานหลากหลายแต่ในบทนี้จะกล่าวถึงรายละเอียดเกี่ยวกับกลุ่มค าสั่ง
พื้นฐานที่ใช้งานเป็นประจ า 
 
1. กลุ่มค าสั่ง Bit Logic 

การเขียนโปรแกรม PLC ซึ่งใช้ค าสั่งพื้นฐานกลุ่ม Bit Logic ถือว่ามีข้ันตอนที่ไม่ซับซ้อนและง่ายต่อการเขียน
โปรแกรม โดยค าสั่งกลุ่ม Bit Logic จะมีดังนี้ 
 

 
 

รูปท่ี 7.1 การเลือกใช้งานค าสัง่กลุ่ม Bit Logic จากแถบค าสั่ง 
 
 
 
 



 

ตารางท่ี 7.1 ความหมายของค าสั่งกลุม่ Bit Logic 

ค าสั่ง สัญลักษณ์ ความหมาย 

Normally Open 
 

 เป็นค าสั่งหน้าสมัผสัปกติเปิดที่อ้างอิงค่าจากหน่วยความจ า 
หน้าสัมผสัจะปิด (NC) เมื่อ Input เป็น 1 

Normally Closed 
 

 เป็นค าสั่งหน้าสมัผสัปกติปิดทีอ่้างองิค่าจากหน่วยความจ า 
หน้าสัมผสัจะเปิด (NO) เมื่อ Input เป็น 0 

Normally Open 
Immediate  

 เป็นค าสั่งรับค่า Input ที่มีการเปลี่ยนแปลงแบบทันทีทันใด 
หน้าสัมผสัจะปิด (NC) เมื่อ Input เป็น 1 

Normally Close 
Immediate  

 เป็นค าสั่งรับค่า Input ที่มีการเปลี่ยนแปลงแบบทันทีทันใด 
หน้าสัมผสัจะเปิด (NO) เมื่อ Input เป็น 0 

Not 
 

 เป็นค าสั่งที่หน้าสัมผัสจะเปลี่ยนสภาวะของ Input เป็นตรงกันข้าม 

Positive 
Transition  

 เป็นหน้าสัมผัสที่ ON เป็นระยะเวลา 1 scan time เมื่อมีการ
เปลี่ยนแปลงสัญญาณในช่วงขอบขาข้ึน (off-to-on) 

Negative 
Transition  

 เป็นหน้าสัมผัสที่ ON เป็นระยะเวลา 1 scan time เมื่อมีการ
เปลี่ยนแปลงสัญญาณในช่วงขอบขาลง (on-to-off) 

Output 
 

 เป็นค าสั่งแสดงผลของ Output 

Output 
Immediate  

  เป็นค าสัง่แสดงผลของ Output แบบทันททีันใด 

Set (N bits) 
 

 เป็นค าสั่งที่ใช้กระท าการ Set หรือ Reset ค่าที่ต้องการ (bit) ย่าน
ของต าแหน่งทีส่ามารถท าการ Set หรือ Reset ได้คือ 1-255 ตัว หาก
ใช้ค าสั่ง Reset กับ T (Timer) หรือ C (Counter) จะมผีลท าให้ค่า
เวลาของ Timer และค่าการนบัของ Counter ถูกเคลียร์ไปด้วย Reset (N bits) 

 

Set Immediate 
(N bits)  

 เป็นค าสั่งที่ใช้กระท าการ Set หรือ Reset ค่าที่ต้องการ (bit) ย่าน
ของต าแหน่งทีส่ามารถท าการ Set หรือ Reset ได้คือ 1-128 อักษร 



 

Reset Immediate 
(N bits)  

“I” บอกให้ทราบว่าเป็นค าสั่งที่มีการท างานแบบทันทีทันใด นั่นคือ 
Output ของ PLC จะเปลี่ยนแปลงทันทีทันใดเมื่อสิ้นสุดค าสั่งนี ้

Set Dominant 
Bistable 

 

 เป็นค าสั่งที่ให้ความส าคัญที่การ Set ถ้า Set (S1) และ Reset (R) 
มี Input เป็น 1 จะท าให้ Output (OUT) เป็น 1 ด้วย 

Reset Dominant 
Bistable 

 

 เป็นค าสั่งที่ให้ความส าคัญที่การ Reset ถ้า Set (S) และ Reset 
(R1) มี Input เป็น 1 จะท าให้ Output (OUT) เป็น 0 ด้วย 

No Operation 
 

 เป็นค าสั่งที่ไม่มผีลต่อการท างานของโปรแกรมและค าสัง่ไมส่ามารถ
ใช้งานในโหมด FBD Operand โดย Operand N สามารถก าหนดค่า
ได้จาก 0-255 

 
2. ตัวอย่างการเขยีนโปรแกรมกลุ่มค าสั่ง Bit Logic 

2.1 ตัวอย่างการใช้งานค าสัง่ NC, NO และ Output 

 
 
 



 

Timing diagram ของค าสั่ง NC, NO และ Output 

I0.0

I0.1

I0.3

I0.4

Q0.0

Q0.1

Q0.2
 

 
2.2 ตัวอย่างการใช้งานค าสัง่ Positive และ ค าสั่ง Negative Transition 

 
 
 
 
 



 

Timing diagram ของค าสั่ง Positive และ ค าสั่ง Negative Transition 

I0.0

I0.1

I0.2

Q0.0

Q0.1

Q0.2

Q0.3
 

 
2.3 ตัวอย่างการใช้งานค าสัง่ Set และ ค าสัง่ Reset 

 
Timing diagram ของค าสั่ง Set และ ค าสั่ง Reset 

I0.0

I0.1

Q0.0 – Q0.3
 

 
 
 



 

... ใบความรู้ ... 
      บทท่ี 1  

ค าสั่งพ้ืนฐานในการเขียนแลดเดอร์ไดอะแกรม 
 
 ในการเขียนโปรแกรม PLC เพื่อควบคุมการท างานในรูปแบบต่างๆ นั้นก็จะมีลักษณะการเขียนได้หลาย
ภาษาดังได้กล่าวไปแล้วในบทที่ผ่านมา แต่ส าหรับบทต่อไปนี้จะเป็นการเขียนโปรแกรมในภาษาหนึ่งที่มีลักษณะรูป
คล้ายวงจรทางไฟฟ้า หรือที่เรียกว่าแลดเดอร์ ซึ่งการเขียนโปรแกรมภาษาแลดเดอร์ จัดว่าเป็นภาษาที่ในการเขียนที่
เป็นลักษณะของสัญลักษณ์ที่เราสามารถดูโครงสร้างและเข้าใจการท างานได้เป็นอย่างดี 
 ในการใช้ค าสั่งต่างๆ ของ Software STEP7-Micro/WIN ในการเขียนโปรแกรมเพื่อสั่งงาน PLC Siemens 
S7-200 ก็จะมีกลุ่มค าสั่งต่างๆ ให้เลือกใช้งานหลากหลายแต่ในบทนี้จะกล่าวถึงรายละเอียดเกี่ยวกับกลุ่มค าสั่ง
พื้นฐานที่ใช้งานเป็นประจ า 
 
3. กลุ่มค าสั่ง Counter 

การเขียนโปรแกรม PLC ควบคุมการท างานของเครื่องจักรที่มีการนับจ านวนช้ินงานจ าเป็นต้องใช้ค าสั่งช่วยใน
การเขียนโปรแกรม หรือใช้ค าสั่งกลุ่ม Counter ซึ่งมีหลายฟังก์ช่ันให้เลือกใช้ข้ึนอยู่กับลักษณะงานที่ต้องการควบคุม 
โดยค าสั่งกลุ่ม Counter จะมีดังนี้ 
 

 
 

รูปท่ี 7.2 การเลือกใช้งานค าสัง่กลุ่ม Counter จากแถบค าสัง่ 
 
 
 
 
 
 
 
 
 



 

ตารางท่ี 7.2 ความหมายของค าสั่งกลุม่ Counter 
 

ค าสั่ง สัญลักษณ์ ความหมาย 

Count Up 

 

 เป็นค าสั่งนบัข้ึน (CU) โดยจะนบัช่วงขอบขาข้ึนของ CU 
และเมือ่นับค่าการนับ (Cxxx) เพิ่มข้ึนจนกระทั่งเท่ากบั หรือ
มากกว่า Preset Value (PV) Counter bit จะ ON และ 
สามารถ Reset ได้เมื่อ Input R อยู่ในสภาวะ ON และจะหยุด
นับเมื่อค่าการนับเท่ากบั PV 

Count Down 

 

 เป็นค าสั่งนบัลง (CD) โดยจะนับจากค่า PV เมื่อนับลงจนถึง 
0 Counter bit จะ ON และสามารถโหลดค่าได้ เมื่ออินพทุ LD 
มีสภาวะON 

Count Up/Down 

 

 เป็นค าสั่งนบัข้ึนและนบัลง (CD) เมื่อค่าการนบั (Cxxx) 
เพิ่มข้ึนหรือเท่ากบั PV Counter bit จะ ON และสามารถ
รีเซทได้เมื่ออินพุท R อยู่ในสภาวะ ON 

High Speed Counter 
Definition 

 

 เป็นค าสั่งใช้ในการก าหนด MODE อ้างอิง ของ HSC 

High-Speed Counter 

 

 เป็นค าสั่งที่ใช้ในหน่วยความจ าพิเศษ โดยพารามเิตอร์ N จะ
ระบจุ านวนของ HSC (ใน CPU226 จะมี 6 HSC) 

Pulse Output 

 

 เป็นค าสั่งที่ใช้ในการตรวจสอบ bit ในหน่วยความจ าพิเศษ 
(Q0.0 หรอื Q0.1) 

 
 
 
 
 
 
 



 

4. ตัวอย่างการเขยีนโปรแกรมกลุ่มค าสั่ง Counter 
4.1 ตัวอย่างการใช้งานค าสัง่ Count Up 

 
Timing diagram ของค าสั่ง Count Up 

I0.0 Up

I0.1 Reset

C0 Current

C0 (bit)
Q0.0

1

2

3

 
4.2 ตัวอย่างการใช้งานค าสัง่ Count Down 

 
 



 

Timing diagram ของค าสั่ง Count Down 

I0.0 Down

I0.1 Load

C1 Current

C1 (bit)
Q0.0

2

1

3

2

33

0

3

 
4.3 ตัวอยา่งการใช้งานค าสัง่ Count Up/Down 

 
Timing diagram ของค าสั่ง Count Up/Down 

I0.0 Up

I0.1 Down

I0.2 Reset

C48 Current 0

4

0

C48 (bit)
Q0.0

1

2

3

4

5

3

4

5

 



 

... ใบความรู้ ... 
      บทท่ี 1  

ค าสั่งพ้ืนฐานในการเขียนแลดเดอร์ไดอะแกรม 
 
 ในการเขียนโปรแกรม PLC เพื่อควบคุมการท างานในรูปแบบต่างๆ นั้นก็จะมีลักษณะการเ ขียนได้หลาย
ภาษาดังได้กล่าวไปแล้วในบทที่ผ่านมา แต่ส าหรับบทต่อไปนี้จะเป็นการเขียนโปรแกรมในภาษาหนึ่งที่มีลักษณะรูป
คล้ายวงจรทางไฟฟ้า หรือที่เรียกว่าแลดเดอร์ ซึ่งการเขียนโปรแกรมภาษาแลดเดอร์ จัดว่าเป็นภาษาที่ในการเขียนที่
เป็นลักษณะของสัญลักษณ์ที่เราสามารถดูโครงสร้างและเข้าใจการท างานได้เป็นอย่างดี 
 ในการใช้ค าสั่งต่างๆ ของ Software STEP7-Micro/WIN ในการเขียนโปรแกรมเพื่อสั่งงาน PLC Siemens 
S7-200 ก็จะมีกลุ่มค าสั่งต่างๆ ให้เลือกใช้งานหลากหลายแต่ในบทนี้จะกล่าวถึงรายละเอียดเกี่ยวกับกลุ่มค าสั่ง
พื้นฐานที่ใช้งานเป็นประจ า 
 
5. กลุ่มค าสั่ง Timer 

การเขียนโปรแกรม PLC ควบคุมการท างานเครื่องจักรให้ท างานตามก าหนดเวลา การเริ่มท างาน หรือการหยุด
ท างานตามล าดับข้ันตอนการท างาน จ าเป็นต้องใช้ค าสั่งช่วยในการเขียนโปรแกรม หรือใช้ค าสั่งกลุ่ม Timer ซึ่งมี
หลายฟังก์ช่ันให้เลือกใช้ข้ึนอยู่กับรูปแบบของการหน่วงเวลาในลักษณะงานต่างๆ ที่ต้องการควบคุม โดยค าสั่งกลุ่ม 
Timer จะมีดังนี้ 

 

 
 

รูปท่ี 7.3 การเลือกใช้งานค าสัง่กลุ่ม Timer จากแถบค าสัง่ 
 
 
 
 
 
 
 
 



 

ตารางท่ี 7.3 ความหมายของค าสั่งกลุม่ Timer 
 

ค าสั่ง สัญลักษณ์ ความหมาย 

On-Delay Timer 

 

 เป็นค าสั่งการนบัค่าเวลาโดยจะเริ่มนบัเมือ่อินพุท (IN) มี
สภาวะ ON และ Timer Bit จะมสีภาวะ ON เมื่อค่าเวลาการ
นับมีค่าเท่ากับหรือมากกว่าค่าเวลาที่ ก าหนดไว้ (PT) 

 ค่าเวลาการนับของ ON-Delay Timer จะเริม่นับจนกระทัง่
ถึงค่าเวลาที่ตั้งไว้ (PT) และจะยังนับตอ่ไป จนกระทัง่ถึง
ค่าสูงสุดที่ 32,767 และสามารถเคลียร์ค่าเวลาการนับ ได้ด้วย
การก าหนดให้ Input (IN) มีสภาวะ OFF 

Retentive On-Delay 
Timer 

 

 เป็นค าสั่งการนบัค่าเวลา ชนิดคงค่าเวลาการนับได้ โดยจะ
นับเมื่อ Input (IN) มีสภาวะ ON และ Timer bit จะมสีภาวะ 
ON ก็ต่อเมื่อค่าเวลาการนบัมีค่ามากกว่าหรอืเท่ากับค่าเวลาที่
ก าหนดไว้ (PT) 

 ค่าเวลาการนับของ Retentive On-Delay Timer จะยังคง
ค้างค่าเวลาการนบัแม้ว่า Input (IN) และ Timer bit จะมี
สภาวะเป็น OFF ดังนั้นจึงสามารถใช้ Timer ประเภทนี้ส าหรับ
นับช่วงเวลาการ ON ของ Input (IN) ได้ ส าหรบัการเคลียรค่์า
เวลาการนบั สามารถเคลียร์ได้ด้วยค าสั่ง Reset (R) 

Off-Delay Timer 

 

 เป็นค าสั่ง Timer แบบหน่วงเวลา OFF ส าหรับการท างาน
ของ Timer ชนิดนี้ เมื่ออินพุท ON จะให้ Timer Bit มีสภาวะ 
ON ทันทีเช่นเดียวกันกบัสภาวะ Input และค่าเวลาการนับของ 
Timer Bit จะยงัคง ON อยู่พร้อมกับ Timer เริม่นับค่าเวลา
จนกระทั่งถึงค่าเวลาทีก่ าหนด (PT) Timer Bit จึงเปลี่ยน
สภาวะเป็น OFF และค่าเวลาการนับของ Timer ก็จะหยุดลง
ด้วย  

Beginning Interval 
Timer 

 

 เป็นค าสั่งที่ใช้อ่านค่าการนับค่าของช่วงเวลา 1 ms และท า
การเกบ็ค่าไว้ที่ OUT 

 ช่วงเวลาสูงสุดทีส่ามารถเก็บค่าได้เท่ากับ DWORD 
millisecond 



 

Calculate Interval 
Timer 

 

 เป็นค าสั่งที่ใช้ในการค านวณค่าระหว่างค่าของเวลา (EN) 
กับช่วงของเวลา (IN) โดยผลต่างของการค านวณจะท าการเก็บ
ค่าไว้ที่ OUT 

 ช่วงเวลาสูงสุดทีส่ามารถเก็บค่าได้เท่ากับ DWORD 
millisecond 

 
6. ตัวอย่างการเขยีนโปรแกรมกลุ่มค าสั่ง Timer 

6.1 ตัวอย่างการใช้งานค าสัง่ On-Delay Timer 
 

 
Timing diagram ของค าสั่ง On-Delay Timer 
 

 
 
 
 
 
 
 
 
 



 

6.2 ตัวอย่างการใช้งานค าสัง่ Retentive On-Delay Timer 
 

 
Timing diagram ของค าสั่ง Retentive On-Delay Timer 
 

 
 
 
 
 
 
 



 

6.3 ตัวอย่างการใช้งานค าสัง่ Off-Delay Timer 
 

 
Timing diagram ของค าสั่ง Off-Delay Timer 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

วิทยาลัยการอาชีพพิมาย 
แบบประเมินผล บทที ่1 โปรแกรมเมเบิลคอนโทรลเลอร ์    แผนกวิชาไฟฟ้าก าลัง 
วิชา ระบบควบคุมในงานอุตสาหกรรม (3104-2007)     เวลา 120 นาท ี
ผู้ออกข้อสอบ อ.ธนเศรษฐ สุขสว่าง      คะแนน  30 คะแนน 

ค าชี้แจง 
1. อนุญาตให้น าเอกสารเข้าในหอ้งสอบ 
2. ข้อสอบมีทั้งหมด 4 ข้อให้ท าทุกข้อ 

--------------------------------------------------------------------------------------------------------------------------------- 
ช่ือ .......................................... สกลุ........................................... รหัสประจ าตัว ................ ............................... 
--------------------------------------------------------------------------------------------------------------------------------- 
 
1. จงอธิบายการท างานของแลดเดอร์ไดอะแกรมต่อไปนี ้

 
 
............................................................................................................................. .................................................
............................................................................................................................. .................................................
..................................................................................................................................................................... 
 
2. จากแลดเดอร์ไดอะแกรมที่ก าหนดให้ เอาทพ์ุต Q0.0 จะท างานเมื่อ ท าอะไร จ านวนกี่ครัง้  

 
 
..............................................................................................................................................................................
............................................................................................................................. .................................................
............................................................................................................................. ........................................ 
 



 

3. T37 เป็น Timer ที่มีการท างานแบบใด 

 
 
......................................................................................................................................................... .....................
.............................................................................................................. ................................................................
............................................................................................................................. ........................................ 
 
4. จงออกแบบโปรแกรมควบคุมการท างานของมอเตอรส์ามเฟส แบบสตาร์ทมอเตอร์โดยตรง (Direct Start) 

 
ก าหนดต าแหน่งอินพุท เอาท์พุท 

สถานะ ต าแหน่ง สัญลักษณ์ และความหมาย  

   
   
   
   
   



 

เขียน Ladder Diagram และ Timing Diagram 

 
  
     

   


